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Overview
ClipMate™ is designed to enhance the native capability of the Windows clipboard.    From a functional 
standpoint, the Windows Clipboard works exactly as it should: allowing the user to transfer an item of data
within an application, or between applications.      In practice, however, the Clipboard falls short in that it 
can only hold one item of data at a time.    Multiple formats yes, but still the same item of data.    When you
perform a CUT or PASTE, the clipboard is emptied, and your new piece of data is now the sole occupant 
of the clipboard.    There is no ability to append new data onto the existing clipboard data, no UNDO 
capability, and no long-term memory.    That's where ClipMate steps in!

ClipMate adds several value-added enhancements to the operation of the Windows Clipboard.    It allows 
you to keep many generations of previous Clipboard occupants, (Clip Items) for later retrieval.    If there is 
a particular piece of data that you use often, it can be stored indefinitely in ClipMate's SAFE LIST.    You 
can append multiple CLIP ITEMS into a single piece of data for pasting into an application, through a 
process called Gluing.    You can browse and edit the CLIP ITEMS in ClipMate's MAGNIFICATION 
WINDOW.    There is a function to remove unwanted line breaks in your text, and you can print with the 
press of a button.

With ClipMate 2.0, you can now use ClipMate to collect additional data types, such as BITMAP, 
PICTURE, RTF, and OLE objects.    The new PowerPaste™ feature allows you to paste data into your 
applications quickly and easily.    Once activated, ClipMate enters a kind of "auto pilot", sensing when 
you've pasted data, and automatically advancing to the next clip item for you.

Related Topics:
Here's how ClipMate operates



Here's how ClipMate operates
ClipMate sits idle most of the time, waiting for any activity in the Windows Clipboard.    Whenever you put 
anything on the Clipboard (by CUTting or COPYing), ClipMate gets a message from Windows.    ClipMate 
checks to see if the Clipboard is holding any desirable formats.    If there is, ClipMate automatically makes
of copy of the data for itself.    It places the new data in one of its lists, creates a title, and displays the title 
in the text window at the top of the Clip Item Selection List Box.    If the Magnification Window is active, 
the new Clip Item is displayed within it. 

Access to the ClipMate's data is easily obtained through the use of a drop-down list, or a graphical grid, 
showing thumbnail sketches of the data.    After you make a selection, ClipMate automatically copies that
item to the clipboard.    It is then ready for your use in any application that offers clipboard support for the 
data formats contained within the item.



Features new to version 2.0

Support for Graphics, and other Large Datatypes
ClipMate now supports non-textual datatypes, such as BITMAP, PICTURE, RTF, and even OLE objects.    
ClipMate's advanced memory management and filtration facilities allow you to collect these large 
datatypes without draining your system memory and resources.

For more information see: Clipboard Formats.

PowerPaste
ClipMate has always had the ability to automatically collect data in the background, as you work within 
your application.    PowerPaste lets you use your data just as easily.    Simply turn PowerPaste on, go to 
your application, and start pasting.    When ClipMate detects that you've pasted data, it automatically 
advances to the next clip item.    Paste again, and you get the second item of data.    Paste once more, 
and you get the third item.    You have the option of working your way up the clip list (toward newer data) 
or down the clip list (toward older data).    

This feature is particularly powerful when working with applications that won't accept Glued data, such as 
an order-entry screen.    

For more information see: PowerPaste™.

Filtration
ClipMate's FILTER facility allows you to pre-determine which datatypes will be collected by ClipMate.    
This will save resources, and time, as ClipMate won't be asking the clipboard to provide data that you 
don't need.    

For more information see: Filtering Clip Items.

Filter Wizard
V2.01 introduces a "Wizard" to assist in the understanding and creation of filters. 

For more information, see: Filter Wizard

Load On Demand
Large data types such as BITMAP, PICTURE, RTF, and OLE, require a lot of memory.    ClipMate normally
stores these large items on disk, until needed.    When you access a Clip Item, ClipMate checks to see if it
is in memory, or on disk.    If it is on disk, it automatically re-loads it for you.    

For more information see: Memory Management with "Load On Demand".

Thumbnail View
There is a new way to select Clip Items.    Using the ThumbNail View Window, you can see a grid of 
thumbnail sketches of BITMAPs, PICTUREs, or even text.    The grid is configurable to show from 2x2 to 
8x8 images.    with an option to show graphics, text, or both.    When viewing thumbnails of text items, you 
can use a very small font, so that you can visually select text items by their appearance.

For more information see: Visual Selection by ThumbNail.



Drag and Drop
You can use the File Manager to drag and drop BITMAP files (.BMP) onto ClipMate.    They will then be 
available to paste into other applications, without the work of copying them from another application, such
as Paintbrush.    They behave like regular clip items, except that the actual .BMP files will NOT be deleted 
by ClipMate when the clip item is deleted by the user, or during the normal purge process of the 
recyclable list.

Magnification Window
There have been several enhancements to the popular Magnification Window.    Most importantly, it can 
display graphics as well as text.    The browse << >> buttons have been altered to indicate UP/DOWN, to
better accommodate the vertical nature of the clip lists.    There are some new informational fields, that 
display the data/time of creation, the name of the application that created the data, and the serial number 
of the clip item.    The Item Size field has been enhanced to show different measurements, according to 
the nature of the data displayed.    There's also a DONE button for convenience.

For more information see: Magnification Overview.



Basic Installation
System Requirements
Installation



System Requirements
To run ClipMate, you will need the following.

Microsoft Windows 3.1 or later.

VGA (or better) video.

Minimum 500K disk space (for the program and typical collection of data).

Minimum 4MB of RAM, if you wish to collect large data types, such as Bitmaps.



Installation
Note: You can install directly from a floppy, or from a hard drive.    These directions assume that you're 
installing from the A: floppy, and that the files are de-compressed.    Make appropriate substitutions if you 
are using the B: drive, a CD ROM, or have already copied the files to a directory on your hard drive.    

1. From the Program Manager's FILE menu, choose the RUN command.

2. Enter A:Setup 

3. You will be presented with the INSTALL.TXT file, from within Notepad.    Be sure to read, any 
WARNINGS that are present.    Quit out of Notepad, by selecting FILE | EXIT.

4. You will then be presented with the installation dialog box.    By default, ClipMate will be installed 
into C:\ClipMate.    If you wish to override this, just highlight and overtype the directory in the 
"Install to Directory" field.    Press OK to continue.

5. The files will now be copied.    Note that if the source and target directories are the same, then no 
files will actually be copied.    Also, if you are installing on top of a previous version of ClipMate, 
then you may be prompted to approve replacement of files with the same name.

6. The next prompt will ask you whether or not the ClipMate icon should be added to the Program 
Manager.    If you answer OK, then the setup program will create a ClipMate group, and place the 
ClipMate icon in it, along with icons for various documentation files.    It is strongly suggested that 
you move or copy the ClipMate icon to the STARTUP group, so that it will run automatically, every
time that you start Windows.    

If you are installing over a previous version of ClipMate, your data will be converted to the new format 
when you first run ClipMate.    If you have multiple files, you'll have to open and save each one separately. 
By default, ClipMate will try to store all new data files in the \CLIPMATE\DATA subdirectory.

If you're a new ClipMate user, please see:Overview, and Features new to version 2.0.



Advanced Installation
Windows 3.1 users can take advantage of the HOTKEY, RUN MINIMIZED, and STARTUP GROUP 
features that are inherent to Windows 3.1 (and presumably any future releases of Windows).

Related Topics:
Hotkey
Run Minimized
Startup Group
Specifying Data Files
De-Installation
Distribution Files
ClipMate.INI
What ClipMate Does to Your System
Known Problems



Hotkey
You can set a hotkey combination to activate ClipMate (once it's running) and bring it to the top of all other
windows.    To use, highlight the ClipMate icon in the Program Manager (the one that's actually on the 
Program Manager, NOT the one that represents the running application.)    Select FILE | PROPERTIES 
from the Program Manager's menu.    You will be presented with the Properties dialog box for ClipMate.    
Click your mouse in the Hotkey field.    Give it a hotkey, probably some combination of Ctrl + Alt + 
whatever you want.    We use Ctrl+Alt+C (C as in ClipMate!).



Run Minimized
If you normally wish ClipMate to be iconified when run, you can set the properties of the ClipMate icon to 
cause ClipMate to start as an icon.    To use, highlight the ClipMate icon in the Program Manager (the one 
that's actually on the Program Manager, NOT the one that represents the running application.)    Select 
FILE | PROPERTIES from the Program Manager's menu.    You will be presented with the Properties 
dialog box for ClipMate.    Check the Run Minimized check box.    That's it!



Startup Group
The Startup Group is a Windows 3.1 feature that lets you easily determine which programs will 
automatically execute when Windows is loaded.    You will probably want to put ClipMate in your startup 
group.    



Specifying Data Files
If you wish to use a filename for your data, other than DEFAULT.CLM, you can specify your filename as a 
parameter to ClipMate.    In this case the Command Line in the Program Manager would be:    

C:\ClipMate\ClipMate.exe myfile.clm



De-Installation
In the event that you need to de-install ClipMate, there is a short write-up in the CLMREAD.TXT file.    



Distribution Files
The following files are provided with ClipMate, and constitute a complete ClipMate package:

CLIPMATE.EXE The executable program - requires Windows 3.1

CLIPMATE.HLP Help file

CLMICONS.DLL Dynamic Link Library to support the Toolbar.

CLMREAD.TXT README file with any special considerations or installation notes

CLMREG.TXT Registration form    

SITELIC.TXT Registration form for Site Licenses, Multi-User Licenses

VENDOR.DOC Vendor Description for Shareware vendor or BBS Sysop

FILE_ID.DIZ BBS Standard Description File

SETUP.EXE Installation Program

SETUP.INF Installation Program



ClipMate.INI
The ClipMate.INI file holds various settings and preferences, and is saved every time that ClipMate is 
shut down, whether or not a change has actually taken place.    It has nothing to do with the ASK USER 
vs. ALWAYS SAVE option, found in the CONFIG screen.    Currently, there is a seperate section for the 
Thumbnail Configuration, called GraphConfig.    Both sections are listed here:

[ClipMate]
AlwaysSave=1
AskUser=0
RecyclableList=1
ActiveList=0
KeepOnTop=0
MaxView=1
BeepOk=0
RecyclableLength=100
X=0
Y=0
magX=100
magY=100
magW=490
magH=300
graphX=10
graphY=10
graphW=310
graphH=310
SerialNumber=1
WizFilterEnabled=1
Registered Name=Not Registered
Registered Number=

;Optional - Delay during PowerPaste
PPDelay=100   ;(100 miliseconds)

[GraphConfig]
Cfg_Text=1
Cfg_Graphics=1
Cfg_Bitmap=0
Cfg_PICT=1
Cfg_Font_Size=12
Cfg_Dimension=4
ThumbW=74
ThumbH=62

What ClipMate Does to Your System
The first time that you run ClipMate, it will create \Windows\ClipMate.ini.    WIN.INI is not altered in any 
way, nor are any of your other system files.    

ClipMate will create a |ClipMate\data directory, where it will store the data that it collects.    You will be 
prompted for permission to create this directory, when ClipMate is run for the first time. 

ClipMate will save the clipboard data into DEFAULT.CLM, or another .CLM file that you specify.    



Known Problems
Norton Desktop for Windows users will need to upgrade to Norton Desktop version 2.0 in order to use 
ClipMate.



Main Window Overview
ClipMate's Main Window contains a drop-down Combo Box, showing the title of the currently-selected clip
item, a toolbar, and pull-down menus.    Buttons and menus provide access to other ClipMate windows, 
and functions.    Often, the buttons will change their appearance, to indicate a particular mode of 
operation, or they may be grayed-out, to indicate the inability to access a particular function.

For More Information See:
Clip Item Selection List Box, and 
Toolbar.



Layout - Full vs. Brief
ClipMate gives you the option of displaying all of its graphical controls, along with the Menu (Full Layout), 
or just showing some of the graphical controls, with no Menu (Brief Layout). 

Why would you want to turn this option off?

Sometimes, you don't need the full functionality of ClipMate, and would gladly trade some functionality for 
valuable screen space.    This is especially true when you are using the "Keep Window On Top" option, 
found in the CONFIG dialog box.    Thus, the Brief View was created to fill this need.    

The Brief Layout gives you the PowerPaste, Delete, Print, Glue and Magnify buttons, along with the 
Config, Multi Select, and About buttons.

Trade-Off:
When in Brief Layout, not all features are accessible.    In particular, you lose the ability to switch back and
forth between the Recyclable List    and the Safe List.    In the Full Layout, you have access to all features, 
but ClipMate takes up more screen space.    



Clip Item Selection List Box

The Clip Item Selection List Box is your primary method for recalling data back onto the clipboard.    You 
will use the mouse to activate it, and then make your selection from it's scrolling list of Clip Item Titles.    
Once you've made your selection, the selected Clip Item is copied onto the Clipboard.    

Related Topics:
Using the Mouse
Using The Keyboard
Rules of Thumb



Using the Mouse
The Clip Item Selection List is used to copy CLIP ITEMS from one of the Clip Item Lists back onto the 
Clipboard.    You can accomplish this by simply selecting the title of a stored Clip Item from the Clip Item 
Selection List. 

The Clip Item Selection List is a standard Windows Combo Box, which incorporates a static text window 
with a drop-down list.    By clicking the down arrow icon to the right of the text window, you will see a 
scrolling list, by title, of the Clip Items in the active list.    When you have made your selection, the list will 
go away, the title of the selected Clip Item will appear in the text window, and the item will be copied to the
Clipboard.



Using The Keyboard
Alternatively, you can use the up and down arrows on the keyboard to make the selection.    This 
sometimes has an advantage, such as when you are browsing the list through the magnification window.   
It is very easy to sequentially zip through each Clip Item by hitting the down-arrow cursor key.    In order to
use the cursor key, you must first give input focus to the list box, or the text window at the top of the list 
box.    To do this, simply click on the text window itself with the mouse, and it will appear as reverse video, 
indicating that it has the input focus.    You should learn to use both methods, as they each have 
advantages.



Rules of Thumb
· Whenever either of the Clip Item Lists becomes active, the top entry of the active list will be 

shown in the text window, and therefore will also be copied to the Clipboard.    This includes the 
initial activation of the Recyclable List, upon startup.

· Whenever the Clipboard contents are erased by an application, or it contains only formats that 
are filtered out by the user-definable filter, the selection list will display a message stating that the 
clipboard is empty, or invalid.

· During certain operations where there is no single current selection, such as Multi-Select, the 
selection list box may display messages, stating that such an operation is taking place.    



Toolbar
        Multiple Selection List Dialog Box  

        ThumbNail Select  

         PowerPaste™  

    Delete  

    Print Text Item  

    Glue Text  

    Magnify Button  

    Copy to Safe List  

    Activate Recyclable List  

    Activate Safe List  



Multiple Selection List Dialog Box
This option consists of a dialog box that allows you to select more than one Clip Item at a time, as 
compared to the Clip Item Selection List Box, which will select only one Clip Item at a time.    There are 
several operations that take advantage of the multiple selection, such as Delete, Print, Glue, and Copy to 
Safe List.

The Multiple Selection Dialog Box consists of two List Boxes:

The Selection List in on your left.    This is where you make your selections.

The Confirmation List is on your right.    This shows your selections in the order in which you made them.   
It is for your reference only, and can't be manipulated.

Here's how to use the Multiple Selection Dialog Box:

1) If you will need to see the Magnification Window, activate it first before opening the Multiple 
Selection Dialog Box.    Use of the Magnification Window is highly recommended, because it 
makes it easy to see what you are selecting.

2) Press the MS button to bring up the dialog box.    Once the dialog box is up, you can't go back to 
the rest of ClipMate without pressing either OK or CANCEL.

3) If necessary, move and/or re-size the Magnification Window.    

4) The Selection List appears in the list box on the left.    With the mouse or spacebar, select the 
Titles of the Clip Items that you want to work with.    As you make each selection, the Clip Item 
you select is displayed in the Magnification Window.      The Magnification Window only holds one 
Clip Item at a time, so only the most recent selection will be shown.    To de-select, simply click 
again.

5) In the Confirmation List (on the right), your selections will appear in the order that you selected 
them.    This READ ONLY window provides visual confirmation that you have selected the items in
the order that you intended.    It is especially helpful when Gluing Clip Items, because it gives an 
outline of what you are composing.      For the Copy to Safe List operation, the order also comes 
into play.    The items will be copied to the Safe List in the order that you selected them, and 
therefore the order that they appear in the Confirmation Window.

6) If you change your mind about a particular item, just click it again.    The highlighting will 
disappear, and it will be removed from the Confirmation List on the right.    You can select and de-
select as many times as you want.    

7) When you are done with your selections, press OK.    

8) The Delete, Print, Glue, and possibly Copy to Safe (depending upon what list is currently active) 
buttons will now be enabled.    You can now perform any of these functions using the multiple 
selection.



ThumbNail Select
Availability: This button is only available in the    Full Layout.

Opens or closes the Graphic Selection Window

For more information see: Visual Selection by ThumbNail



PowerPaste™
Availability: This button is available in both the Full Layout and the Brief Layout.

When activated, PowerPaste allows you to paste multiple items into an application, without having to 
continuously access ClipMate in order to select the next item.    This gives ClipMate a "hands-off" mode, 
and makes it quick and easy to use ClipMate's data.    

As you paste data into an application, ClipMate senses that you've pasted the current item, and 
automatically advances to the next item.    Paste again, and you get the second item.    Paste once more, 
and you get the third item.    This process continues until you deactivate PowerPaste, or you reach the 
end of the clip list (in the chosen direction).

Related Topics:
Direction - Up or Down?
Selecting The Starting Position
Activating PowerPaste
Ending PowerPaste
Real-Life Example
Troubleshooting PowerPaste



Direction - Up or Down?
As PowerPaste advances its way through the current Clip List, it can either work its way UP (toward 
newer data) or DOWN (toward older data).    Once activated, you can keep pasting until you encounter 
either the top or bottom of the current list.    You select the direction by pressing one of the two "outlets" 
that form the PowerPaste button.    

It is useful to note that when Power Pasting, there is nothing that prevents new data from being copied 
into ClipMate.    It will appear on top of the list, and not at the location of the PowerPaste pointer.    So, if 
you're Power Pasting UP, you can encounter this new data if you continue far enough.    

In the following example, the user has set the Start Point at "Item W", and pressed the UP PowerPaste 
button.    Therefore, pasting data into an application will yield Item W, Item X, Item Y, and then the "Brand 
New Item Z", which enters ClipMate after the PowerPaste has been initiated.    

There are many possibilities.    You could start with "Item A", and work your way up through all of the 
items, in their original sequence.    Or you could start at the top of the list, and work your way down, in 
reverse order.

Note: The direction of PowerPaste determines whether you get the data in the order that you copied, or in
reverse.    UP will preserve the order, DOWN will reverse it.



Selecting The Starting Position
Power Paste will begin with the currently-selected Clip Item, which will be visible in the Clip Item Selection
Box.    If you have made no selections, this will be the top of the current list, by default.    This is often 
suitable for Power Pasting DOWN.    If you want to PowerPaste UP, then you won't get very far, unless 
you select a starting point farther down the list.    Of course, if you plan on copying more data to ClipMate, 
then the top might be a fine place to start.



Activating PowerPaste
The PowerPaste button is actually two buttons, an upper outlet, and lower outlet, which correspond to 
PowerPaste (up) and PowerPaste (down) from the EDIT menu.    

When you press either outlet, it "Glows" to show you that it is active.    If you press the other outlet, it will 
Glow, and the other one will return to normal.    In this way, it works much like a pair of Radio Buttons, as 
they are mutually exclusive.    



Ending PowerPaste
Click on the active "outlet", and the operation will end.    Note that if you reach either end of the list, the 
operation will automatically terminate, with an audible Beep.



Real-Life Example
At Thornton Software Solutions, we use PowerPaste every time that we fill orders.    Many of our orders 
come by Compuserve's SWREG service, which is very popular with our customers.    While the electronic 
form was always readable and quick, it didn't really save us any time during order entry, as it isn't in a 
format that our order entry system can use.    Early versions of ClipMate helped somewhat, as we could 
copy the data fields, and then paste them (one at a time) into our order entry screen.    Unfortunately, this 
meant a lot of toggling back-and-forth between our order entry screen, and ClipMate.

PowerPaste solves this problem.    Now we just copy the individual fields from the order (Name, Company,
Street1, Street2, City, State, Zip, Country, Quantity, CompuServe ID) into ClipMate.    We do all of the 
orders at once, so there could be a lot of data (the more, the better!)    Now, we pull down the Clip Item 
Selection List, to select the first item of data that we want to past (the customer name of the first order).    
Then, we go to the order-entry screen and tab to the "Customer Name" field.    Paste the data, tab to 
"Company Name" field.    Paste the data, and tab to the next field.    Paste and tab, until the whole order is 
done.    Begin a new order, and repeat the paste-tab process.    

As you can see, this is much easier than toggling back and forth to ClipMate, in order to retrieve the data. 
And compared to keying-in all of this data, it's fantastic!

Note: In the above example, we used the TAB key a lot.    This has nothing to do with ClipMate, or 
PowerPaste.    It is just used to navigate from one field to another, in our order-entry screen.



Troubleshooting PowerPaste
There can be problems PowerPasting into certain applications that hold the clipboard open too long when
pasting.    You will get a message from ClipMate saying that there is an "Error Opening Clipboard".    A 
possible work-around is to slow down the PowerPaste action, by adding the following line to the \
WINDOWS\CLIPMATE.INI file, under the [CLIPMATE] heading:

PPDELAY=500

The delay interval is in milliseconds (1000 ms = 1 second).    The default is 100, which is nearly 
instantaneous.    Slowing it down will give your application more time to paste its data, but you need to 
keep this delay in mind when pasting, as you can get ahead of PowerPaste.    



Delete
Availability: This button is available in both the Full Layout and the Brief Layout.

This operation works with single or Multiple Selections.

Deletes the currently selected Clip Item or Items from the Active List.

The next item in line is then copied to the Clipboard, and that item is shown in the Clip Item Selection List 
Box.



Print Text Item
Availability: This button is available in both the Full Layout and the Brief Layout.

This operation works with single or Multiple Selections.

Prints the currently selected Clip Item or Items

This Function ONLY WORKS WITH TEXT 
Shortcut: Ctrl+P

Printer support is very generic.    Output will appear in a font that is supported by your printer, such as 
Courier.    There are no options for fonts, margins, or such.    The purpose of this is so that ClipMate can 
give basic printer services to as many printers as possible.    Now, ClipMate users can print any text that 
they can get into the Clipboard - with only a mouse click!    If you need more sophisticated printing, just 
paste your data to any application that meets your needs!

Item(s) will be printed to the default Windows printer, unless you have specified a printer using the Print 
Setup option, found in the FILE menu.    Once you have chosen a printer with Print Setup, it stays that 
way until you change it to something else.    It is not reset upon shutdown.    This makes it very convenient 
for users with more than one printer.    Many ClipMate users direct their ClipMate output to their desktop 
(dot-matrix) printer, while leaving their shared network (laser) printer for other tasks, such as word 
processing.    

NOTE:    The notion of retaining a printer selection from session to session is not typical practice in 
Windows.    However, it makes sense in this case.    If you use ClipMate to make 3270 emulation more 
bearable, I'm sure you'll agree.    There is a potential pitfall that could arise, if you were to delete the 
printer definition for the printer that you have chosen as ClipMate's printer.    If you do this, just select 
another printer with the Print Setup option of the File menu.    



Glue Text
Availability: This button is available in both the Full Layout and the Brief Layout.

This feature operates on text items only.  If you glue several items that contain multiple formats, only 
the text component will be Glued.

This feature was known as CONCATENATE in previous versions of ClipMate.

The Glue function concatenates (appends together) selected Clip Item(s) into one big Clip Item.    The 
resulting item is then copied back onto the Clipboard, for use by other applications.

There are two ways to use this feature.    The first method is to turn the "Glue Mode" on, and then copy 
data to the clipboard.    As each item enters the clipboard, ClipMate "Glues" it to the previous occupant of 
the Clipboard.    We'll call this "Auto Glue".    The second method is to glue existing clip items together 
within ClipMate.    We'll call this "Manual Glue".

Related Topics:
Auto Glue
Manual Glue (Formerly known as Concatenate)



Auto Glue
Auto Glue is a special mode of operation, where ClipMate appends each new text item directly to the end 
of it's predecessor, rather than creating new Clip Items for each new piece of text.    If you turn on the 
Glue mode, and then copy 10 paragraphs to the clipboard from other applications, you will have ONE Clip
Item that is 10 paragraphs long.    In addition, the resulting Clip Item will always be on the Clipboard, and 
will be up-to-date (as long as Auto Glue is still on).    You won't even have to interact with ClipMate at all to
use this new item.    

To use, just click the Glue Button, or select Glue Together from the Edit menu.    You should NOT perform 
a Multiple Selection prior to entering Glue Mode.    Doing so would invoke a "Manual Glue", which is 
discussed on the next page.

When you enter Glue Mode, a fresh, empty Clip Item is created.    It will initially have a title stating <<Glue 
In Process...>>.    As you Copy text from other applications, the title will change to indicate the number of 
items that have been Glued together.    To finish, click on the Glue Button again.    The title will change to 
<<Glue Finished, (x) Items>>, and ClipMate exits Glue Mode.    At any time during the Glue operation, you
can utilize the new item, in its current state.    

The Auto-Glue Mode will end automatically if you try to use other ClipMate functions while it is active.    
You may open or close the Magnification Window, but only to browse the data.    Any other action will 
terminate the current Glue operation, as if you had pressed the Glue Button to turn the Glue off.    Once 
stopped, you can't re-start a Glue.    however, you can perform a Multiple Selection, and use the Manual 
Glue to put several Glues (or single items) together.



Manual Glue (Formerly known as Concatenate)
This operation requires you to have previously performed a Multiple Selection.

The Manual Glue is useful for making one large Clip Item from several smaller items.    You select the 
items that you want by performing a Multiple Selection, and then pressing the Glue Button (or Glue 
Together from the Edit menu.)    

One advantage that Manual Gluing has over Auto Gluing is that you don't have to plan it in advance.    
Another is that it is easy to change the order of the result, as the Multiple Selection gives you the ability to
select items in any order that you want.    

Example of Manual Gluing in action:
Let's say that you need to buy a PC for your office at work.    You sign onto the on-line corporate catalog, 
and browse around to see what's out there.    Whenever you see something that you want, copy it to the 
clipboard.    When you're done shopping, use the Multiple Selection List Dialog to select the components 
of your new computer system, in whatever order you want.    Use the GLUE button to combine your 
Multiple Selection into one big Clip Item that you can then paste into the order form, or on-line order 
screen.    Painless!



Magnify Button
Availability: This button is available in both the Full Layout and the Brief Layout.

Also accessible from the View Menu.

Opens, or Closes the Magnification Window.    

When the Magnification Window is open, the Magnify Button will appear to be Checked.    In this way, it 
functions like a standard Windows Check Box.    When you press it again, it pops up, and the 
Magnification Window closes.    

For more information, see Magnification Overview.



Copy to Safe List
Availability: This button is not available in the Brief Layout.    

Copies selected Clip Item(s) to the Safe List.          

This operation is only available when the Recyclable List is the Active List.

This operation works with single or Multiple Selections.



Activate Recyclable List
Availability: This button is not available in the Brief Layout.

Also accessible from the View Menu.

Causes the Recyclable List to become the Active List.

The Recyclable Button and Safe Button are bound together, and act like radio buttons.    When you press 
one, it takes on a depressed appearance, and the other button pops out.    This way, it is easy to see 
which list you're working with.



Activate Safe List
Availability: This button is not available in the Brief Layout.

Also accessible from the View Menu. 

Causes the Safe List to become the Active List. 

The Recyclable Button and Safe Button are bound together, and act like radio buttons.    When you press 
one, it takes on a depressed appearance, and the other button pops out.    This way, it is easy to see 
which list you're working with.



MENUS
While ClipMate's most often-used features are represented by buttons on the toolbar, there are still more 
functions to be found in the menus.    The next several pages describe the functions that are found in the 
menus.    Full descriptions are given for functions that are unique to the menus.    Where a toolbar 
equivalent exists, a reference is made to that description.    

Menus are not available in the Brief Layout.

Related Topics:
File Menu
Edit Menu
View Menu
Config Menu



File Menu
The File menu includes commands that enable you to open and save ClipMate files.

For the most part, it will not be necessary for you to ever choose any of these.    ClipMate will 
automatically open DEFAULT.CLM when it launches, or a file that you specify on the command line (of the
icon that launches ClipMate).    Upon closing, ClipMate will attempt to save both of the Clip Item Lists into 
the current file.    Depending upon the option that you have selected in the CONFIG screen, you may be 
prompted before the file is saved.    Therefore, if you always use DEFAULT.CLM,    you will never need to 
use the FILE menu.    

Here are the menu options:

· New Clears storage, creates a new file.

· Open Opens existing file.

· Save Saves current file.

· Save As Saves with new name.

· Print Setup Set printer    See: Print Text Item.bmchelp0008.bmp..PrintTextItem.43.

· Print Item(s) Prints current item, or multiple-selection of items    See: PRINT.

· Exit Ends ClipMate.    Alternatively, double-click on the control box (in the upper left 
hand corner) in the main window.

If Always Save is checked in the CONFIG screen, then the current file (usually 
Default.Clm) will automatically be saved.    Otherwise, you will be prompted to 
save changes, if either list has been added to or modified in any way.    The 
ClipMate.INI file in the Windows directory will be updated upon exiting from 
ClipMate.    



Edit Menu
The Edit Menu allows you to manually alter the contents of either of the two lists.

Most commands are available on the Icon Bar, and are further described in the MAIN WINDOW section.

· Edit Title Changes the title of a Clip Item.

The Edit Title dialog box allows you to change the Title of a Clip Item.    
Although the title is initially constructed from the first 50 characters of the Clip 
Item, changing the title will have no effect on the Clip Item.    It is provided for 
your reference only.    

As an alternative to this dialog box, you can edit the title in the Magnification 
Window.    

· Delete Item Remove Clip Item from active list See Delete.

· Copy to Safe List Puts a copy of the selected Clip Item on the Safe List. See Copy to Safe List.

· Glue Glues CLIP ITEMS together. See Glue Text.

· PowerPaste Up/Down - Initiates/Terminates PowerPaste.    See: PowerPaste™.



View Menu
The View Menu allow you to change the Active List, open or close the Magnification Window, or perform 
word searches with the Find or Find Next commands.    

Most commands are available on the Icon Bar, and are further described in the MAIN WINDOW section.

· Activate Recyclable List See: Activate Recyclable List.

· Activate Safe List See: Activate Safe List.

· Magnify See: Magnification Overview.

· Find See Find, Find Next.

· Find Next See Find, Find Next.

Related Topics:
Find, Find Next



Find, Find Next
You can use the accelerator keys, (CTRL+F and CTRL+N, respectively) even if the view menu is not 
visible (Brief Layout).

The Find command will prompt you for some text to search for, and then search the Active List for the first
occurrence of the specified text.    It is NOT case sensitive, and you can use partial words.    Wild Cards 
are NOT supported.

If the string is found, the corresponding Clip Item is selected, and displayed in the Title Window of the Clip
Item Selection List Box.    If not, then you will receive a notification message, and the Title Window will be 
blank.

If the Magnification Window is active, then it will also reflect results of the search, in the same way that 
the Title Window of the Clip Item Selection List Box does.    



Config Menu
User Preference Dialog Box
FILTER



User Preference Dialog Box
Accessible from the CONFIG pull-down menu (when ClipMate is in the Full Layout) or the CFG Button 
(when ClipMate is in the Brief Layout).    

The Config Dialog Box lets you change various settings of ClipMate's main window.    The settings are 
stored in the ClipMate.INI file for later retrieval.    

Automatically Save Current File When Shutting Down?
When you close ClipMate, a check is made to see if the current file needs saving.    If so, then this value 
determines whether ClipMate will prompt you first before saving the file.    The "Current File" is the .CLM 
file that ClipMate is currently using to store the clipboard data.

Default: Always Save 

Where to Put New Clipboard Items?
When ClipMate detects that there is a new Clip Item to retrieve from the Clipboard, it must decide which 
list to put it in. If the Recyclable List is currently active, then the new item will always go there.    If the Safe
List is active, then it checks this value, and places the item accordingly.    This is useful in order to keep 
from cluttering up your Safe List with trivial items, if you happen to have the Safe List active.    On the 
other hand, you may want to turn on Current Active List, if you want to collect some items that you want to
keep for a long time.

Default: Recyclable List

Length of Recyclable List
This allows you to control the length of the Recyclable List.    ClipMate will accumulate Clip Items in the 
Recyclable List, and allow the list to grow until this limit is reached.    When the list is at its limit, the oldest 
item will drop off from the bottom for every new item added to the top.    

Trade-Off:
Increasing this value will cause ClipMate to keep more Clip Items, but the trade-off is that it will use more 
memory.

Default: 100 (Clip Items saved in the Recyclable List)

Keep Window on Top?
This allows ClipMate to "float" to the top of all other windows.    It is especially helpful when you have a lot 
of windows open, or if you are using an application that is running full-screen, such as a word processor. 

If you find that the Full Layout takes up too much of your screen space, try the Brief Layout.    

If it still takes up too much screen space, try minimizing it to an icon, which will also "float" on the screen.   
You can position the icon anywhere that you want,    even in the same position that you want ClipMate to 
occupy.

Version 2.0 Enhancement

ClipMate now uses the new "floating window" feature of Windows 3.1, which eliminates some of the 
problems with the solution previously used.    

Default: unchecked (no)

Full Layout?
ClipMate gives you the option to display all of its graphical controls, along with the Menu (Full Layout), or 
just show some of the graphical controls, with no Menu (Brief Layout).    This is where you make that 
choice.

Default: Full Layout

Beep When Clipboard is Updated?



ClipMate has the option of beeping every time that the clipboard is updated.    This is often a useful tool 
for learning how ClipMate works, or how various applications behave.    

Default: unchecked (no)

Max Size for Clip Item
This setting applies only to version 1.x releases, and was eliminated in version 2.0.    The Load On 
Demand technology made this feature obsolete.



FILTER
This opens the FILTER dialog box, which allows you to determine which formats ClipMate will collect.    

For more information on Filters, see: Filtering Clip Items



Help Menu

About 
Accessible from the Help | About pull-down menu (when ClipMate is in the Full Layout) or the ? Button    
(when ClipMate is in the Brief Layout).    

In addition to displaying the "normal" about information, this Dialog Box gives you the opportunity to 
register ClipMate, and access the on-line help.    The HELP button is provided in order to give access to 
HELP when ClipMate is in the Brief Layout. 

Help Info:
· Release Date If over 1 year old, get a new copy.

· Number of Clip Items: Total of both Recyclable and Safe Lists.

· Registered To: Hopefully You! 



Magnification Overview
The Magnification Window displays the Clip Item that is currently selected in the Clip Item Selection List 
Box.    It is used to get a full look at what the Clip Item actually looks like, rather than just a glimpse of the 
title.    Also, you can edit either the Clip Item (text only), or the Title.    There is a powerful Flow Paragraph 
function that will reformat the Clip Item into paragraph format.      This makes the text more usable by 
word-processing applications.

For information on the controls in this window, see: Magnification Controls.

Related Topics:
Opening & Closing the Magnification Window



Opening & Closing the Magnification Window 
The Magnification Window is opened by either selecting the Magnify option under the View menu, or by 
pressing the Magnify Button.    Upon opening it the button will display its "Depressed" state.

The Magnification Window is closed in the same way that it is opened.    Press the Magnify Button, and 
you will see it pop back up from its checked state as the Magnification Window closes.    Alternately, you 
can double-click on the control box in the upper-left of the window.



Magnification Controls
Browse Buttons
Make Title
Wrap Text Checkbox
Flow Paragraph Button



Browse Buttons
The Browse Buttons will select the previous/next Clip Item in the Active List. 

Moves you toward the top of the list (Newer Clip Items), 

Moves toward the bottom of the list (Older Clip Items).    
As items are selected, they are Copied to the Clipboard automatically.    
If you try to browse past either end of the list, ClipMate will issue a short beep to let you know that there is
nothing to browse in that direction.



Make Title
The Make Title button will form a new Clip Item Title from the selected text.    This is useful for when the 
Clip Item contains a text passage that you want to use as the title.    

To use, just select some text (with your mouse), and then press the button.    ClipMate will make a new 
title out of the selected text, up to the first 50 characters.    The new title is immediately reflected in the title
box, and the Clip Item Selection List Box.



Wrap Text Checkbox
The Wrap Text Checkbox is used to control whether or not the Magnification Window displays the Clip 
Item in a wrapping edit box, or not.    If the edit box doesn't wrap, then a horizontal scroll bar is provided.

It is set automatically when you perform a Flow Paragraph.    Each Clip Item knows whether or not it 
should wrap.    As you browse through Clip Items, the check box will change, to reflect the wrap state for 
the current item.    You can click it to change the setting for a given item.    

The setting is embedded within the Clip Item, and is therefore stored to disk between sessions.



Flow Paragraph Button
The Flow-Paragraph button re-formats the Clip Item so that it may be easily used by word processors.    It 
removes all of the extra line breaks and spaces that often are embedded within text that is copied to the 
Clipboard.    Here's an example:

If your text looks like this when it gets into your word processor:
    This is some text that was taken 
from DOS and
it doesn't fit very well into the 
word processor.  
I would rather let the word processor 
make the important
decisions, such as where the margins should 
go, and whether 
the paragraph should be indented.  I hope I 
don't have to 
manually remove all of that junk! 

You can use the Flow Paragraph button to make it look like this:
This is some text that was taken from DOS and it doesn't fit very well 
into the word processor.  I would rather let the word processor make the
important decisions, such as where the margins should go, and whether 
the paragraph should be indented.  I hope I don't have to manually 
remove all of that junk! 

The newly-formatted text only has line breaks that define the end of a paragraph, or breaks between 
paragraphs.    Individual lines flow together to form paragraphs.    You can then use your word processor to
format the paragraph any way you want!

As most applications have their own quirks about how they put text on the Clipboard, ClipMate's 
conversion algorithm is pretty generic at this point.    It should cover most cases - if you find a 
shortcoming, please contact the author, and describe your particular situation and applications involved.    
Here is a summary of the algorithm that ClipMate currently uses to convert paragraphs:

1. Any blanks at the beginning of any line are removed.

2. Any occurrence of multiple blanks is removed, with the following exception: Two blanks are 
allowed to follow a period.

3. Any Line Break that is not immediately preceded or followed by another Line Break is removed.

You can convert more than one paragraph at a time, as long as there are at least two line breaks between
them.    One of these terminates the last sentence of the first paragraph, and the other one splits the two.   
More line breaks are ok.    If only one line break is used, then the paragraphs will be joined together.

Related Topics:
Displaying Wrapped Text:



Displaying Wrapped Text:
In order for the newly-formatted text to display properly in the window, the Wrap Text Checkbox is 
automatically turned on when you press the Re-Flow Paragraph button.    This is necessary, as the 
paragraphs are not broken up with line breaks, and won't display correctly on their own.    Keep this in 
mind when you are browsing through the Clip Items.    When you come across an item that has been re-
formatted this way, you need to check this option.    Also, Clip Items that aren't formatted this way will look 
strange when forced to wrap in a narrow window.    However, if the window is wide enough, then the text 
won't get a chance to wrap anyway.



Editing
You may edit either the text of the Clip Item, or its title.      When you edit the title, it won't appear in the 
Clip Item Selection List immediately.    The Clip Item Selection List will be updated when another Clip Item
is selected.    Editing the title has the same effect as Edit Title.    

Related Topics:
Editor Hot Keys
Power Editing in the Magnification Window



Editor Hot Keys
The following standard Windows Accelerator keys (hot keys) can be used in the Magnification Window:

Key(s) Function
Backspace Deletes the character to the left of the insertion point.    

Del Deletes the character to the right of the insertion point. 

Ctrl+X CUT Deletes the selected text and places it on Clipboard.

Ctrl+C COPY Makes a copy of the selected text and places it on Clipboard.

Ctrl+V PASTE Inserts text from Clipboard to the active window.

Note: Cut/Copy/Paste cause the clipboard to be updated, and therefore cause the Magnification Window 
to display whatever you have just copied to or pasted from the Clipboard.    To use this effectively, see 
POWER EDITING on the next page.

Note: The Magnification Window remembers its size, and location, even from one session to the next,    
because these values are stored in the ClipMate.INI file.



Power Editing in the Magnification Window    
You can copy part or all of the Magnification Window to the Clipboard, and thus back into ClipMate by 
using the accelerator key for copy: Ctrl+C.    To do so, just select the text that you want to copy, and press 
Ctrl+C.    You are then presented with only the text that you have selected.    How is this?    Your new text 
was Copied to the Clipboard, and so ClipMate made itself a copy.    New Clip Items are always made the 
current selection, as they reflect the current Clipboard contents (unless the Safe List is currently active).    



Visual Selection by ThumbNail
The ThumbNail Window is accessed by selecting "ThumbNail Select" from the VIEW menu, or by 

pressing the  button.
The Graphic Select window is used to select Clip Items visually from a grid, consisting of ThumbNail 
images.    The dimensions of the grid can range from 2x2 up to 8x8.    When a BITMAP image is too large 
to fit within the bounds of its square in the grid, it is scaled down to a ThumbNail sketch.    PICTURE 
images always scale up or down to fill their square, as PICTUREs are scalable, by nature.    Text items 
can be shown, as well.

This screen shot shows a 2x2 grid of 4 items.    The first is small enough that it doesn't require a 
ThumbNail.    The next is a scaled-down version of the original "arches.bmp".    Following that is a 
PICTURE image of the "ClipMate at Work" graphic.    It is automatically scaled to fit within its box.    The 
last is a text item, scaled down to a very small font.    Although the text can't be read, the distinct layout of 
the text often gives a visual cue as to the nature of the text, or the origin.    In this case, this data is from 
an electronic order for ClipMate, which has a distinct visual format, and can be easily recognized.    

Selection of data is performed by clicking on a square with the mouse.    If you open the Magnification 
Window, you'll see your selection take place.    

Sometimes you'll notice a green rectangle surrounding an item.    This is to let you know that this item 
doesn't yet have a ThumbNail.    This occurs when items are new, or if the grid has been made smaller 
since they were originally copied.

Note: After    the ThumbNail Window has been partially or completely covered by another window, it uses 
some shortcuts when re-drawing itself.    While this is usually a big time-saver, it may occasionally 
produce garbage within the ThumbNail Window.    To correct this, just re-size the window slightly with the 
mouse, by clicking and dragging on either of the borders.    The window will now be re-drawn correctly.

Related Topics:
ThumbNail Controls
ThumbNail Configuration Dialog Box



ThumbNail Controls

Each ThumbNail is a Button
Just click on a picture to load its larger counterpart into ClipMate, and make it the current clip item.

Browse Buttons
Let you page forward and back, a screenful at a time.    

Done
Quit this Window.    Alternatively, you can double-click on the control box (the funny rectangle at the 

upper-left of the Window), or press the     button.

Config
Opens the Graphic Configuration Dialog Box.    

See: ThumbNail Configuration Dialog Box.

Mag
Opens or closes the Magnification Window.    Although there are several other ways to open/close the 
Magnification Window, this button is also added as a convenience.    Note that the two windows will be 
easiest to use when they do not overlap each other.    We suggest finding good "homes" for the 
Magnification Window, and the ThumbNail Window, and leaving them in the same place most of the time. 

See: Magnification Overview.

Help
Summons Help for this window.



ThumbNail Configuration Dialog Box
This dialog allows you to configure the appearance of the ThumbNail Window.

Display Mode
You have the option of showing text, graphics, or both in the Graphic Select window.    Use the Display 
Mode to set your preference.

Text - allow text to display.

Graphics - allow graphics (BITMAP, PICTURE) to display.

Display Preference
If both BITMAP and Picture are present, which one is shown?

Font size for Text
The size that text items will be displayed in the grid.    This has absolutely no relationship to the font which
the data was displayed in when it was originally copied, nor does it affect the data later on, when it is 
pasted to something else.    It is simply for purposes of display in the graphic selection window.

X*Y Dimension
Determines the dimension of the grid.    From 2x2 squares up to 8x8 squares. 

Refresh Thumbnails On Save?
For the sake of speed, and convenience, the thumbnails are stored on disk, once the item that they 
represent has been saved.    As the window size is adjusted, they aren't re-sized, as they are often "close 
enough" to do the job.    You can force a re-generation of all thumbnails by checking this box, and then 
saving the clip file (from the Main Window's FILE | SAVE menu, or by shutting down ClipMate).



Clipboard Formats
The Windows clipboard can simultaneously hold the same data item in many different formats.    To 
ensure compatibility and interoperability with as many applications as possible, most software packages 
will provide data in several formats.    There are extreme examples, such as Microsoft Excel, which often 
provide as many as 17 clipboard formats, representing the same item of data!    

Analysis shows that not all formats are viable, once the host application loses ownership of the clipboard. 
Many of these formats simply evaporate, and others become invalid.    

Furthermore, many of these data types become quite large, and can quickly become a drain on 
resources.    For example, if you copy a screenful of spreadsheet cells, you could end up with a 300-600K 
BITMAP, and a large PICTURE drawing of your cells, along with your data!

To top it off, many of these formats aren't usually provided at the time of the copy.    Instead, applications 
will simply inform the clipboard that they CAN provide these formats.    Think of it as a sort of "advertising".
When an application actually asks for the data in a particular format, then the clipboard informs the host 
application that the particular format is requested, and the host application then provides the data.    This 
process is known as "Delayed Rendering", and can cause ClipMate to appear to dramatically increase the
time needed to copy data.    

So far, it sounds like a lot of bad news.    Will ClipMate's new features bury you in data that you don't want,
and make it take longer to copy data?    The answer is NO!    ClipMate's new FILTER facility allows you to 
determine what formats will be retained, and which formats will be ignored.    The filtration can be defined 
globally, or by application by application, to give you the flexibility that you need.

For more information on the use of Filters, see: "Filtering" Filtering Clip Items

Related Topics:
TEXT
OEMTEXT
OWNER DISPLAY
BITMAP
PICTURE (Metafile)
RTF
Private Formats
OLE (Object Linking and Embedding)



TEXT
An array of character data with a hard return terminating each line, with no associated font, size, margins,
or other formatting.    



OEMTEXT
Data is identical to TEXT format, but the Clipboard Viewer displays it with a proportional font.    
Applications receiving data don't treat it any differently, so there is no value in capturing OEMTEXT when 
TEXT is available.    For that reason, ClipMate always ignores OEMTEXT.



OWNER DISPLAY
Also Known as Owner Draw.    This is not really a clipboard format at all, because it is just a method for a 
host application to display it's data within the window of another application, such as the Clipboard 
Viewer.    There is no data on the clipboard, so ClipMate will always ignore this transient format.



BITMAP
A graphic image, composed of individual pixels, or dots.    ClipMate can handle bitmaps of 2, 16, or 256 
colors.    When displayed on a video adapter capable of displaying 256 colors, bitmaps are often 
accompanied by a palette, which optimizes the colors of the display to enhance the image.    When 
running 24-bit video cards, with the proper drivers, a palette is not needed, and is not usually present.

Bitmaps are often used for very complex images originating from the real world, such as photographs.

Bitmaps are common in Windows, and can be created by the Paintbrush program that comes with 
Windows.



PICTURE (Metafile)
The proper name for this format is actually METAFILE.    It is also called MetafilePICT, and Vector 
Drawing.    

Metafiles are graphic images that consist of one or more common drawing objects, such as rectangles, 
circles, lines, and formatted text. Metafiles are most suited to human- or machine-generated images, such
as architectural or engineering drawings, or clip art.    Metafiles are scalable, and they often look as good 
full-screen as they do when scaled down.    Metafiles often contain text, with font information.    This often 
makes them desirable for corporate logos.    When printed, the image is re-drawn at printer resolution.    If 
you have True Type fonts in a Metafile, they will look FANTASTIC when printed.

Most commercial drawing programs can generate Metafiles, and so can the OLE drawing module 
(DRAW) that comes with many of the Microsoft products.

The "ClipMate at Work" and "PowerPaste at Work" diagrams in this manual are Metafiles.



RTF
Rich Text Format (RTF) is a private clipboard format employed by Microsoft applications, to enable them 
to share formatted text.    Several non-Microsoft packages have adopted this format, as well.    RTF 
contains all of the formatting for text, such as font, size, color, margins, borders, etc..    It can even contain
other items, such as graphics and OLE objects.    

RTF is usually very large.    It is not unusual to see RTF clipboard items of 200 - 600K in size.    Also, it will 
usually take an application several seconds to produce the RTF format, and place it on the clipboard.    
The reason that you might not notice the delay, is that RTF is a prime candidate for Delayed Rendering.    



Private Formats
There is an established and publicized list of standard clipboard formats, which are known as public 
formats.    Most of the popular ones are listed above.    Applications may generate their own, private 
formats, at any time.    Public formats are the most useful, because they are usually supported by a wide 
variety of applications.    Examples are Text, BITMAP, and PICTURE.    Private formats, on the other hand,
are generally useless to any application besides the application that created the data.    Sometimes 
several applications from the same vendor will share private formats, which makes them more useful.    
Most often, the data is only useful to the application that created it.

Since most private formats are usually meant to be used only by the originating application, there is a 
potential hazard involved when using them.    Often, these formats are just pointers that refer to data 
structures residing within the original application, and don't actually contain the data at all.    These are 
transient formats. If ClipMate re-posts this format to the clipboard at a later time, the pointers are invalid.   
This can cause a Run-Time Error or GPF in the original application.    If you find that this is the case, you'll
have to remove the offending format(s) from the filter for that application.



OLE (Object Linking and Embedding)
ClipMate has the ability to store OLE objects.    Simply stated, OLE lets applications that use different data
formats share data without converting the data to a common format.    For example, a sound object can be
pasted into a word-processing document.    The sound can then be played back, by activating the object.   
Your word processor doesn't have to know how to play sounds - it just has to follow the rules of OLE.    In 
many cases, the OLE object can be activated or edited by double-clicking on it.    In Microsoft Word for 
Windows, for example, the draw program is an OLE server.    Double-Click on a graphic, and it activates 
the Draw program to edit the object.    Within the Draw program, there is no option to save the file - 
instead, the option is to update the drawing in the Word for Windows document.    You can do the same 
thing with an Excel spreadsheet object.    You can actually embed a spreadsheet within a word processing
document.    Don't like the numbers?    Double-click, to edit the object in Excel.    Instead of saving the 
Excel file, you update the Word document.    In these cases, the Word for Windows document is 
considered to be a Compound Document, because it contains other types of data within itself.    

In the above examples, we have used Microsoft products to demonstrate OLE, because these are the 
tools that we use at Thornton Software Solutions.    Other vendors support OLE as well, and as this 
manual is being written, most of the industry is re-tooling to support OLE v2.0.    

OLE is initiated by an OLE Server copying data to the clipboard, and then and OLE Client pasting that 
data into itself.    The OLE Client looks at the list of available formats, from top to bottom.    If it finds an 
acceptable format, it just uses that format, and doesn't bother with OLE.    Otherwise, it finds the series of 
formats that magically comprise an OLE object, and pastes them into itself, creating the object.    These 
magic formats that make OLE happen are:

1. OBJECTLINK Where did the data come from?

2. OWNERLINK Which application owns the data?

3. NATIVEThe data itself.

4. PICTURE, DIB, or BITMAP The "Presentation Format".    

The Presentation Format is a special case.    One of these formats is used to display the data in the client 
application.    The nature of this depends on the nature of the OLE object.    For a sound object, this would 
be an Icon of the sound recorder.    For a graphic object, this would be a picture or bitmap of the graphic 
itself.    Have you wondered why you get silly icons of certain applications, when you're copying formatted 
text?    This is because the application is conforming to OLE, and your filter is letting it.    

Related Topics:
Using OLE in ClipMate



Using OLE in ClipMate
When defining your filter for any given OLE Server (such as the Sound Recorder), make sure that you 
include all of the necessary formats: OBJECTLINK, OWNERLINK, NATIVE, and a Presentation Format.    
By your having done this, ClipMate will capture and preserve the OLE objects.    Beware, however, as 
OLE objects can get quite large.    



Filtering Clip Items
As discussed in the section on Clipboard Formats, ClipMate would quickly become unusable if it 
automatically captured every item of data, in every format provided.    ClipMate's FILTER facility allows 
you to be selective about the data formats that ClipMate will capture, on an application-by-application 
basis.    

ClipMate's filter facility operates in the following manner: 
Every time that the clipboard is updated, ClipMate's filter performs the following:

1. Find out which application just put data on the clipboard.    Is there a filter defined for that 
application?    If so, retrieve the filter which corresponds to that application.    Otherwise, retrieve 
the "OTHERS" filter, which is the default.

2. Compare the list of data formats that are presently on the clipboard, with the list of formats on the 
currently-selected filter from step 1.    Where there's a match, collect the data in ClipMate.    
Otherwise, ignore the data.

3. While performing step (2), determine whether there are any advanced options defined for this 
filter.    If there are, apply the appropriate rules.    For more information on advanced options, see: 
Advanced Filtration Options.

To support this operation, ClipMate will maintain a list of FILTERS, which indicate which formats are to be 
collected, given the current clipboard owner.    Filters consist of the name of an application, along with a 
list of the desired data formats.    There can also be "Advanced Options", which define special handling for
certain applications.

"OTHERS" Filter
As noted in step (2) above, the "OTHERS" filter is the default, if there is no filter defined for the application
that currently owns the clipboard.    You can alter the list of formats included in the OTHERS filter, but you 
cannot delete the OTHERS filter itself.    

Empty Filters
A powerful, but non-obvious aspect of filters is that you can use them to cause ClipMate to ignore certain 
applications.    To do so, just create an empty filter (a filter, with no formats) for an application.    When that 
application copies data to the clipboard, the filter will be retrieved, but no matches will occur.    So no data 
will be collected by ClipMate.

Related Topics:
Format Viability Test
Creating Filters
Advanced Filtration Options
Filter For TEXT Users
Filter Wizard



Format Viability Test
The Format Viability Test can help you to troubleshoot problems with the clipboard and determine whether
an application does indeed provide any formats that are worth keeping.    Simply put, it involves using the 
clipboard viewer that comes with Windows (clipbrd.exe) to capture data, save it to a file, read the file back
in, and paste it back into the originating application.    There are four likely results:

1. A successful paste, with good-looking data.    This indicates that there is at least one format that 
has what you need.    All you need to do now is to figure out which format is the best, and create a
filter for just that format, and maybe something that will show up in the Mag Window, such as 
Text.    

2. A successful paste, with strange-looking data.    In this case, the application is holding back the 
most useful format.    Microsoft Excel is an example of such an application.    None of its 17 
clipboard formats are as good as an internal paste.    Try experimenting with different filters, to see
which format comes closest.    Hopefully, something will be useful.    

3. A failure message.    The application tried to use one of the formats, but it was invalid.    The 
application was smart enough to recognize this.    Most likely, the offending format is a private 
format, used internally by the application.    It probably is a pointer to some data that is now 
invalid.    See if there are any special paste options, like Paste Special.    Perhaps one of the other
formats will work better?    Try to use ClipMate's filter to eliminate the offending format.    Often, 
private formats will have a name that indicates the application.    You need to find the best 
format(s) to include, and absolutely need to eliminate the offending formats.        

4. A fatal error in the application.    The same case as (3) above, but the application wasn't smart 
enough to see the problem in time.    Use the same techniques to get out of trouble.

Conducting The Test:
1. Close ClipMate, if it is running.    The test will be conducted without ClipMate, in order to avoid 

confusion.

2. Open the Windows clipboard viewer (the one that comes with Microsoft Windows - clipbrd.exe)

3. From AppXYZ (your application), copy some data.    If AppXYZ is a word processor, copy several 
paragraphs, preferably with different fonts.

4. Click on the clipboard viewer.    Pull down the DISPLAY menu, and write down the list of the 
formats provided.    

5. Close AppXYZ.

6. Click on the clipboard viewer AGAIN.    Pull down the DISPLAY menu, and write down the list of 
the formats provided.    Has the list changed?    What's missing?    

7. Save the clipboard to a file, using FILE | SAVE AS.    Call it AppXYZ.CLP

8. Delete the clipboard contents, using EDIT Delete.

9. Open AppXYZ.CLP, using clipboard's FILE, OPEN.

10. Has the format list changed? (Use the DISPLAY Menu)

11. Run AppXYZ again.

12. Paste the data.    Does it look OK?    If so, then we're in business.    One of the formats on the 
clipboard is a winner.    Experiment with filters, and see what you can eliminate.    I recommend 
keeping TEXT, as it will help you to identify data, and see it in the Magnification Window. 

For more information on the cause behind some of the problems outlined here, see: Unfortunate 
Clipboard Tricks.



Creating Filters
The process works like this:

1. From the application that you wish to create a filter for, copy some data to the clipboard.    

2. Open the Filter Dialog Box, from ClipMate's CONFIG menu.    The name of the current clipboard 
owner should show up on the left, under "Current Clipboard Owner".    The available formats will 
be listed below the name of the owner.

3. If a filter already exists for this application, it will show up on the right, under Existing Filters.    This
is ok, because you can add to it.    Skip to step: 5.

4. Press >>Create New Filter>> to make a new, blank filter.

5. Highlight the formats that you want to include in the filter, and press >>Copy Format>>.    The 
formats should now show up in the "Desired Formats:" list.    If ClipMate detects that you've 
selected some particularly problematic formats, it may say so, and skip those formats.

6. If you want to add more formats, just highlight, and copy.

7. Press SAVE to save the filter.

If the application can work with several different types of data, such as formatted text, pictures, OLE 
objects, or graphs, then you might have to repeat steps 1 and 5, as necessary to get all of the formats 
that you want.    You can leave the filter dialog open while you do this.    

NOTE:    If you will be using ClipMate to exclusively capture TEXT items, such as with previous versions 
of ClipMate, see: Filter For TEXT Users

Related Topics:
Filters vs. Filter Formats???
Deleting Filter Formats
Deleting Filters



Filters vs. Filter Formats???
Yes, it does get confusing.    A filter consists of the name of an Owner Application (one that puts data on 
the clipboard), and a list of allowable Formats that can pass through the filter, in to ClipMate.



Deleting Filter Formats
You can delete formats from any filter, by first selecting the filter into the "Existing Filters" list box, 
highlighting the undesired filter, and pressing "Delete Format".    This will leave the filter, but remove the 
unwanted formats.    Press SAVE to make this change permanent.



Deleting Filters
You can delete an entire filter by selecting the filter in the "Existing Filters" list box, and pressing "Delete 
Filter".    This will remove the filter from ClipMate's list of filters.    Press SAVE to make this change 
permanent.



Advanced Filtration Options
The Advanced Options facility is a way to inform ClipMate that it needs to apply certain application-
specific processing rules, when handling data from particular applications.    For example, if ClipMate 
seems to be having trouble collecting data from application XYZ, there may be a timing problem, because
XYZ is holding the clipboard open too long.    You can use the Advanced Options facility to let ClipMate 
know that it needs to delay data capture for 2/10th seconds, when XYZ owns the clipboard.    

Currently, there are two Advanced Options defined in ClipMate.    As users identify more special situations,
they will likely be added to this function.    Here are the current options:

Related Topics:
Delay When Capturing Data
Only use PICTURE from position:



Delay When Capturing Data
If applications seem to have trouble copying data to the clipboard when ClipMate is running, there may be
a timing problem.    Use this option to initiate a small (1/10th second) delay, which will allow your 
application to finish the copy, before ClipMate interferes.    This may be especially helpful when using Auto
Glue, or PowerPaste.



Only use PICTURE from position:
If you find that you end up with senseless pictures of an application's icon when copying non-pictorial 
data, you might be able to use this feature to help ClipMate to only grab "real" Metafiles (PICTURE) and 
leave the "icons" behind.    If you find that when copying "real" pictures, versus non-picture data, that the 
sequence of the formats change, then you might be able to use this option to distinguish between the two 
cases.    

For example:    When copying pictures from Microsoft Word for Windows, the PICTURE shows up as the 
3rd format in the "Available Formats" list.    When copying text, it also provides a PICTURE, but at position
7.    This is the one that you probably DO NOT want.    So set this option to copy only from position 3, and 
you'll keep the good pictures, and leave behind the "garbage" pictures.



Filter For TEXT Users
For those of you who use ClipMate strictly for text, and want to keep it that way, follow these simple steps:

1. Select FILTER from the CONFIG menu (Full Layout).
2. Turn off the Filter Wizard, with the checkbox at the bottom of the dialog.
3. From the drop-down combo box on the right of the dialog box, select the OTHERS filter 

(OTHERS is the default).
4. Highlight any non-text format that appears in the "Desired Formats" list.
5. Press the "Delete Format" button.
6. Repeat steps 3 & 4 until only TEXT remains.
7. Press the SAVE button.
8. Press the OK button.
9. Now, ClipMate will only capture TEXT items, and will behave like previous (1.x) versions of 

ClipMate.



Filter Wizard
A feature introduced in v2.01, the FILTER WIZARD, will facilitate the creation and understanding of 
FILTERS, which are needed to filter out unwanted clipboard data.    The Filter Wizard will activate itself 
when it senses that a filter is needed, to deal with data coming from a particular application.    It will list the
formats currently available on the clipboard, explain a little about them, and let you select the ones you 
want.    Once the filter is created, the Wizard will no longer be invoked in response to data coming from 
the application that you just copied data from, but may be invoked by data coming from other applications.

You can disable the Filter Wizard by unchecking a check box in the FILTER dialog box.    This is 
advisable, only if you wish to rely on the OTHERS format for everything.    Please note that under most 
circumstances, you shouldn't need to disable the wizard, as it will only appear when you are copying from
an application that doesn't have a filter.    Once you've established a good set of filters, it shouldn't appear 
any more.

The Filter Wizard is not a replacement for the regular FILTER dialog, as it doesn't allow you to add 
formats to existing filters.    Many applications present a different list of formats, depending upon what 
you're copying.    Some of the formats that you want in your filter may not be available the first time that 
the Wizard appears.    So, don't let the Wizard short-change you - use the Wizard to make the "first-pass" 
at a filter, and then use the regular FILTER dialog to fine-tune your filters.

For more information see: Clipboard Formats.
For more information see: Filtering Clip Items.



Troubleshooting

Unfortunate Clipboard Tricks
Not all applications treat the clipboard the way that you would expect them too.    In many cases, software 
developers take "shortcuts" when dealing with clipboard operations.    These shortcuts can sometimes 
cause problems when using ClipMate, although they are not usually serious.    We have arbitrarily 
assigned names to these phenomena, such as "Local Clipboarding" and "Silent Clipboarding".    

Related Topics:
Local Clipboarding
Silent Clipboarding
Transient Data



Local Clipboarding
Unfortunately, many applications prefer to use the clipboard only as a means of exchanging data with 
other applications.    When you perform a CUT or COPY with these applications, the clipboard is not 
necessarily updated with the "good stuff" that the application uses internally.    Instead, it creates formats 
that might be useful to other applications.    Subsequently, when you PASTE within the same application, it
tends to use its LOCAL copy, rather than the data that is on the clipboard.    For this reason, data that is 
stored in ClipMate may not exactly match the data that was copied.    



Silent Clipboarding
Some applications, such as the OLE DRAW module that comes with some Microsoft products, use this 
mode of operation.    If you use the DRAW package, and copy several items, you'll find that only the last 
one shows up in ClipMate.    But how is this?    The whole idea of ClipMate is that it holds more than one 
item!    

That is all well and good, as long as applications actually update the clipboard when performing cuts or 
copies.    In order to save time, the DRAW module works locally, and bypasses the clipboard.    When it 
senses that the user has given focus to another window, either by closing DRAW, or by clicking outside of
its borders, it then updates the clipboard.    Thus giving the illusion of clipboard support.    Unfortunately, 
ClipMate can't detect anything that DRAW is doing, until it updates the clipboard.    

There is a clumsy, but effective work-around.    Keep ClipMate visible on the screen while you are working
in DRAW.    If you're working full-screen, make ClipMate float on top, and iconify it.    Or use a hotkey to 
call it to the top.    The idea is that whenever you copy data with DRAW, jut click on ClipMate.    DRAW 
then loses focus, which forces the clipboard update.    ClipMate will then get the data. 



Transient Data
Another trick that applications sometimes play with the clipboard is to provide TRANSIENT data, which 
isn't really data at all.    The most common form of transient data is the OWNER DISPLAY format.    When 
viewed in the clipboard viewer that comes with Windows, the Owner Display format seems to accurately 
represent the data that was copied.    The fonts are the right size, the pictures look great, and it seems to 
take no time at all to copy.    In reality, the data is not really there at all.    The host application is actually 
drawing the data in the window of the clipboard viewer.    This format is absolutely worthless to ClipMate, 
and is therefore ignored.



Memory Management with "Load On Demand"
ClipMate employs a sophisticated scheme called Load On Demand to manage memory and resources 
effectively.    This was made necessary by the additional capability to handle large data types, such as 
Bitmaps and OLE objects.    It is not unusual for bitmaps to occupy several hundred Kilobytes of memory.  
OLE objects, and private data formats, such as RTF can easily exceed 1 megabyte in size.    Early 
prototypes of ClipMate v2.0 illustrated the resource constraints that the new capabilities imposed.    Given 
the fact that many ClipMate users like to store 25, 50, even hundreds of Clip Items, it was decided that 
ClipMate should only load data that was currently in use.    Once data has been saved to disk, it should 
stay there until needed.    So a Load On Demand feature was implemented for any text item over 1k in 
size, and any other format, no matter what size.    

The Catch: Until a clip item has been saved at least once, it must be kept in main memory, and is not a 
candidate for offloading.    They will accumulate in memory until you save the file.    This will not normally 
create a problem, unless you are working heavily with large data items, such as large bitmaps, RTF, or 
OLE objects.    For example, if you are capturing full-size screen shots of 800x600 pixels, you won't want 
to capture more than 4 or 5 before saving the file.    If you are working with small bitmaps, such as 
100x100 pixels, you can probably do as many as you'd like.    

Related Topics:
The DATA Directory:



The DATA Directory: 
ClipMate maintains a DATA directory beneath its home directory, to store all data files.    There is not a 
direct correlation between the number of Clip Items, and the number of files.    If you only use small text 
items, then there will only be the .CLM file (the main ClipMate data file).    If you use complex clip items, 
with several formats, there can be multiple files per clip item.    If you keep lots of clip items, there may be 
quite a few files here.    You'll find the following file types:

.AUX Private formats, RTF, OLE objects, and large text items.    Prefixed with serial number of clip 
item.

.BAK Backup of the .CLM file.    If you have a disaster, you can use this to recover to the last 
successful save.

.BMP Bitmaps.    Prefixed with a serial number.    If the serial number begins with a "t", then they are 
thumbnail bitmaps.

.CLM The main clipmate data file.    It holds text items smaller than 1K, and has pointers to other 
files for the other data types.

.WMF Pictures.    Prefixed with serial number of clip Item.



Support Policy
Registered users of ClipMate are entitled to support for 90 days from the receipt of the registered copy.    
If you have problems using ClipMate, we are here to help you.    You can reach us at any of the following:

CompuServe: (70743,2546)
Phone: (716) 227-6505
FAX (24 hrs): (716) 227-1145.  
Mail: Thornton Software Solutions

Attn: Customer Service
PO Box 26263
Rochester, NY  14626

Please provide a description of the problem, as well as a description of your hardware and software that 
you're using.

If we can't resolve your problem to our mutual satisfaction, we will refund your money, as long as the 
problem is brought to our attention within the 90 day window. 



ASP
Thornton Software Solutions is a member of the Association of Shareware Professionals.    The ASP is an 
association for shareware authors and vendors with the general goals of educating shareware authors 
and distributors and the public, setting standards, sharing resources and information among members. 
Membership is open to programmers who are authors of at least one "nontrivial" product which is 
currently marketed and supported as shareware, who agree to abide by standards adopted by the 
association, and whose membership, in the judgment of the Membership Committee, will not be 
detrimental to the goals or reputation of the ASP. Also, Associate Membership is open to Vendors and 
Bulletin Board operators. 

Whenever you see the ASP logo, or the ASP initials, you are assured that the associated product will be 
fully-functional, and of high quality.    

Related Topics:
OMBUDSMAN



OMBUDSMAN
As an ASP member, we are required to display this statement:
This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help. The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536. 



Tips for the Power User
If you find a tip that you would like to share with other users, send it to us.    If we use it in the manual and 
on-line help, we will credit you as the source!

Related Topics:
ThumbNail Text
Fax Your Signature



ThumbNail Text
You may find it surprisingly easy to use the ThumbNail View to find text items.    The reason for this is that 
you probably have a good idea what certain items look like, whether or not you could quote any given 
word or phrase from it (needed for Word Search).    How many times have you thumbed through a 
magazine, looking for an article?    Often, data that you receive electronically will have a particular visual 
characteristic that you can identify with a glance.    ClipMate's ThumbNail View can help you find those 
items quickly.

Within the ThumbNail Window's Configuration Dialog Box, there is an option for font size.    Use a small 
font, so small that you might not even be able to read the data.    

Place the ThumbNail Window and the Magnification Window side-by-side. 

Don't try to read the thumbnails, look at them    If you see something that looks like it's what you're after, 
click on it, and then read it in the Magnification Window.

For more information, see: Visual Selection by ThumbNail, and    ThumbNail Configuration Dialog 
Box.



Fax Your Signature
Fax modems are handy items, especially for sending documents directly from your word processor.    
Unfortunately, you normally can't sign a document that you're sending, like you can with a traditional fax 
machine.    

ClipMate can't solve this problem all by itself, but it can be part of the solution.    Just sign your signature 
several times on a sheet of paper, and use someone else's traditional fax machine to fax your signature to
your fax modem.    Assuming that your fax modem comes with capable viewer software, you can copy 
your signature to ClipMate.    Title the new item as "My Signature", and move it to ClipMate's Safe List.    
Now, you'll always have your signature ready to paste into FAX documents.    

This tip submitted by Chris Thornton



Questions & Answers
Can I delete multiple Clip Items?
Why do I lose the formatting of text?
When copying bitmaps, why does the ClipMate window flash?
What are    "serial numbers"?
Why can't I paste table cells back into a table (Word for Windows)?



Can I delete multiple Clip Items?
Certainly!    User the Multiple Selection Dialog Box to select all of the items that you want to delete, then 
press the Delete button.    Save the file, and they're gone for good.



Why do I lose the formatting of text?
You are probably filtering-out the format that your application needs, in order to properly format the data.   
By default, ClipMate will accept TEXT and BITMAP, but will ignore everything else.    It sounds like you 
need to develop a good filter, to be used with your application.

For more information, see: Filtering Clip Items



When copying bitmaps, why does the ClipMate window flash?
This is necessary in order to properly adjust the palette, when copying bitmaps.



What are    "serial numbers"?
ClipMate uses serial numbers to name and keep track of the files that are related to a particular Clip Item. 
When a complex, non-textual, item is created, the serial number becomes part of the title.    Other than 
that, it is of little use to you.



Why can't I paste table cells back into a table (Word for Windows)? 
This is an example of where some applications, like Microsoft's Word for Windows, use local data when 
copy & pasting.    You can get table cells into ClipMate through the RTF format, but then WinWord thinks 
you're trying to paste one table into another, which is illegal.    When WinWord is working with local Cut & 
Pastes, it doesn't use the data on the clipboard.



Glossary of Terms
Delayed Rendering
Transient Formats
Title
Archived
Active List
Clip Item
Clip Item Lists
Clipboard
Filters
Layout 



Delayed Rendering
A clipboard technique where the host application will "advertise" clipboard formats, without actually 
providing the data.    When another application requests the data, Windows instructs the host application 
to provide the data to the clipboard.    This makes the initial copy seem fast, since no real work is done.    
This is why you need to be conservative when designing filters - you don't want to wait forever to get your 
data!



Transient Formats
Data items that depend on the originating application for their existence. 



Title
Clip Items have titles that describe the data.    If there is a TEXT format present, then the first 50 
characters are used to create the title.    Otherwise, the title is a combination of the name of the creator, 
the format(s), and the serial number.    You may change the title of any item.



Archived
BBS and Disk vendors often compress and group files together to save space, and keep all of the 
distribution files together.    If the file extension is .EXE, then it is a self-extracting archive.    Just execute it,
and it will unpack itself.    If the extension is .ZIP, then you will need PKUNZIP version 2.0 or later to 
decompress.    



Active List
Whichever of the two Clip Item Lists is currently shown in the Clip Item Selection List Box is the Active 
List.    Its corresponding button will appear to be depressed.    The button representing the other list will be 
sticking up, ready to be pushed.    The lists are mutually exclusive, as only one can be active.



Clip Item
When any application places text on the Clipboard, ClipMate makes a copy for itself.    This copy of the 
clipboard contents is considered to be a Clip Item, and is stored in a Clip Item List. 

A Clip Item will have a Clip Item Title, that is initially constructed from the first 50 characters of the clip 
item.    You may edit this title in the Magnification Window, or by selecting Edit Title from the EDIT menu.

Clip Items are dynamically sized upon creation.    They will typically consume a byte of memory for each 
character in the text, plus 50 characters for the title, and a few extra bytes to keep track of everything.

You can edit the Clip Item in the Magnification Window.    

New Clip Items will be placed on one of the Clip Item Lists, depending upon which list is the Active List, 
and the option chosen in the CONFIG screen.    



Clip Item Lists
Clip Items are stored in Clip Item Lists as they are pasted from the Clipboard.    ClipMate supports two 
Clip Item Lists:

Recyclable List: Maintains a user-defined number of Clip Items.    New Clip Items are at the top of 
the list, and work their way down as still newer items are added.    When the number of Clip Items 
in the list exceeds the user-specified limit, clip items are deleted from the list, thus freeing up 
space in the system.    Since the space is re-usable, the list is known as the Recyclable List.

Safe List: Stores as many Clip Items as you would ever want to keep.    Like the Recyclable
List, new Clip Items enter at the top of the list, and work their way down as still newer items are 
added.    But YOU are responsible for deleting obsolete clip items.    This is a handy way to keep 
track of "Boiler-Plate" items, such as letter templates, return-addresses, or even often-used 
chunks of code, if you happen to be a programmer.

New Clip Items will be placed on one of the Clip Item Lists, depending upon which list is the Active List, 
and the option chosen in the Config screen.    



Clipboard
The Windows clipboard acts as a repository for data in a variety of formats.    Applications can place data 
into the Clipboard, through Copying or Cutting.    Applications can retrieve data from the Clipboard by 
Pasting.    

In actuality, there is no Clipboard program.    At least not in the sense that you could point to a particular 
program, and declare it to be the clipboard.    The Clipboard Utility that comes with Windows is not the 
Clipboard, it is just a utility that can be used to display or delete the contents of the Clipboard.    It does not
have to be open, or even on your hard disk in order to perform Clipboard functions.    In real terms, the 
Windows Clipboard is set of Windows functions that programs use to share data.

The Clipboard can be used to hold a variety of formats, usually simultaneously.    Some common formats 
are Bitmap, Symbolic Link, TIFF, etc.    

This definition is partly based upon the definition of the Clipboard in Tom Swan's Turbo Pascal for 
Windows 3.0 Programming.



Filters
Filters allow you to pre-determine which datatypes will be collected by ClipMate.    This will save 
resources, and time, because ClipMate won't be asking the clipboard to provide data that you don't need. 



Layout 
ClipMate gives you the option of displaying all of its graphical controls, along with the Menu (Full Layout), 
or just showing a some of the graphical controls, with no Menu (Brief Layout).    See CONFIG for details 
on how to change the Layout.



Desirable Formats are those formats that: 1) are supported by ClipMate, and 2) the user wants to capture 
(determined by the FILTER).



To move an icon from one group to another, click on the icon, and drag it to the new group.    Holding the 
CTRL key, causes the icon to be copied, leaving the icon in both groups.



The Font Size displayed in the graphic grid is for local display purposes only, and has no relation to the 
font that was used in the originating application 



Carriage Return + Line Feed




